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Executive summary (maximum 2 sides A4) 
 

 
In previous research in the laboratory, Birch et al (1999) demonstrated the potential transference of undesirable effects of pest-resistant 
GMO's to species occupying trophic levels higher than those of the target pest organism (e.g. a predator of pest aphids). This case 
study involved GNA lectin-expressing GM potato (having partial, antibiosis-based resistance to the pest aphid), the peach-potato aphid 
(Myzus persicae), and the 2-spot ladybird (Adalia bipunctata). The main observed effects, on both the aphid and the ladybird, were 
sublethal, through reduced fecundity and reduced adult weight. Reduced female longevity was also observed in the case of the adult 
ladybird.  Similar prey-mediated adverse effects on predators (lethal  and non-lethal) have been observed experimentally when fed 
target pest from Bt-expressing crops (e.g. Hilbeck et al., 1998).   
 
The results from such contained, laboratory  studies can not be validated at realistic scales in the environment due to restrictions on 
GM field releases. Modelling crop-pest-predator interactions is, therefore, the only feasible precursor to potential field studies.  Such 
models would have to be constructed from information gained from GM crops in other countries (mainly in North America) and from tri-
trophic interactions on non-GM crops in the UK, but would nevertheless lay the foundation for assessing pest-resistant crops should 
they be trialled in the field or grown commercially in the UK. However, most models developed before the start of this project were 
unsuitable, since they incorporated neither sublethal effects nor tri-trophic interactions with predator or parasitoid. To develop a 
predictive capability for pest-resistant GM crops in Europe required a new approach to modelling trophic interactions. 
 
The models were developed in two main stages: first, adapting classical approaches to plant-pest interactions (which did not 
incorporate spatial interactions explicitly); and second, spatially explicit approaches in which individuals of the crop, pest and predator 
grow and interact on a spatial lattice, mimicking field patches and whole fields. 
 
Classical, strategic mathematical models were used to explore crop-pest issues in a general way, since this approach can model 
population scale processes which are applicable across a wide range of systems. The approach was used to understand the dynamics 
of predator-prey systems in which herbivorous pests compete for a common resource. The models incorporated the potential effects of 
non-GM and GM crops through parameters defining feeding, energy budget and mortality. The main findings from this phase of the 
project were related to the incorporation of sublethal effects (here done for the first time), and are presented by Hillier & Birch, (2000; 
2002) and  Hillier et al. (in preparation). They point to the importance of seasonality, through which most of the crop and pest are killed 
periodically (as in winter in the UK) and plant growth rate as factors having a strong influence on the rate at which toxin-resistant pest 
genotypes increase within the pest population. Developments of the clasical approach had limitations however. The parameters could 
only be defined at the whole-population scale, and some important features, including individual variation, spatial heterogeneity, 
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genotype x environment interactions could not be incorporated. Nevertheless, this phase of the work resulted in a detailed exploration 
of the literature to define ranges of parameters (such as crop growth rate, pest feeding rate and crop-to-pest conversion efficiency).  
 
In the second phase, we developed a individual-based, cellular model incorporating defined parameters for plants, pests and predators. 
In this tri-trophic model, individual insects (herbivorous pests and their predators) competed on a spatial lattice over time (up to several 
seasons) for crop resource, in accordance with a set of instructions which related only to that individual and its immediate environment. 
Instead of trying to solve the model in terms of the mathematical equations describing it, we ran and observed targeted simulations, to 
see what effects emerged when individuals behaved according to their prescribed rules. Such an approach allowed for the 
incorporation of the following into the model simulations. (i) Individual insects could be parameterised, leading to natural selection of 
counter-adapting pest sub-populations inside the model over time through altered ecological fitness. (ii) The simulations were played 
out on a spatial lattice, which allowed for uneven distributions of GM and non-GM plant populations density across the lattice, 
simulating pest-susceptible refugia. (iii) As a consequence of this, environment (i.e. anything external to the individual insect) could also 
be varied from cell to cell in the spatial lattice (e.g. a field or region), providing possible variation to the insect phenotype  through its 
environmental interactions. At this stage, we consider the lattice-based, tri-trophic model to be the most advanced in its area. 
 
Because of the large number of variables and the large datasets generated, statistical analysis techniques were used to quantify model 
outputs. These carried the risk that complex or subtle mathematical relationships between input and output variables could have been 
missed, but provided important information additional to that obtained from the strategic models.  
 
The spatially-explicit, individual-based model allows detailed parameterisation for each trophic level (see detailed report) using generic 
physiological (plant, pest, predator) and behavioural (pest, predator) traits derived from the scientific literature. In principle, it can be 
adapted to examine any combination of crop, pest and predator. As a test of whether it could be parameterised for a specific case 
study, typical values for a GM crop type (e.g. oilseed rape) a pest type (e.g. an aphid) and a predator type (e.g. a ladybird)  were added 
to the model to test its functioning and outputs arising from differing GM crop deployment scenarios. Scientific publications on the 
spatial model are being prepared.This project has broadened appreciation of tri-trophic effects in several ways. The background is that 
the crop-pest-predator system is intrinsically prone to instability. Change in food quality of the crop to the target pest can lead to large 
change in the population density of the pest and resulting change, possibly to extinction, of the predator (if no alternative prey of 
suitable food quality are available). Pests themselves can adapt genetically to change in food quality (through an increase in toxin-
resistant biotypes). Stability in the system is therefore preferable, in which toxin-resistant pest biotypes build up very slowly and 
predators remain in coexistence to control the pest. The following findings should be considered in this context.  

• The stability of the system – particularly the coexistence of pest and predator – is strongly affected by the food quality of the 
crop to the pest  (as affected by the GM trait). The degree of reduction in food quality is crucial however. Provided the 
reduction is not too large, increased stability of the crop-pest subsystem would result, which in turn could lead to an increased 
likelihood of the predator persisting to regulate the pest. This stabilising effect on the tri-trophic system is likely to be reversed 
if there was also a reduction in the pest-predator conversion coefficient (as was shown by Birch et al. 1999 for the 
experimental case mentioned above).  

• Contextual factors, such as crop growth rate, and seasonality of crop and pest growth – which have mostly been ignored in 
previous theoretical approaches – should be important in determining the build-up of toxin-resistant pests and the conditions 
under which crop, pest and predator co-exist. They must therefore be included in future theoretical studies. 

• GM crops (or any crops) which retard development or mass gain by the target pest population below set economic thresholds 
via sublethal effects might be equally as effective in controlling the pest as crops producing lethal toxins; and, indeed, more 
beneficial for the environment since (i) the selection pressure favouring the fitter (toxin-resistant) pest genotypes is likely to be 
reduced, and (ii) reducing the pest populations growth rate can potentially stabilise the crop-pest dynamics, thus providing a 
more steady, constant supply of resource for the pests' natural enemies. 

 
They Project has demonstrated that spatially explicit, tri-trophic models can be constructed based on ecological principles and 
populated by plants and insects using information mined from the scientific literature. The models developed in the Project are primarily 
research tools at this stage and require fine-tuning and validation using field data (using GM or non-GM crop data. They have the 
potential in this capacity to (a) help design cropping arrangements (mixtures, refugia) that will delay counter-adaptation buy a pest, (b) 
help design crop genotypes, both GM and non-GM that are appropriate for advanced pest management strategies, (b) and (c) examine 
options for sustaining biodiversity while maintaining crop productivity in cropping systems, including or excluding GM. They could also 
inform and elucidate other tri-trophic case studies that are being carried out in the UK and Europe. Therefore to facilitate dissemination 
and use of the models, the lattice-based model of crop, pest and predator has been fitted with a User Interface which allows tri-trophic 
interactions to be explored under different scenarios by external scientists with guidance from SCRI staff. A copy of the User Interface 
and model are included on a CD submitted with this report. Ultimately, the models have the potential for development as a mangement 
tool. Further funding would be required for that development. 
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Scientific report (maximum 20 sides A4) 
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Recent data from small-scale,  contained release experiments using pest-resistant GM crops  (e.g. Hilbeck 

et al.1998; Birch et al. 1999) indicated the potential for adverse effects to be carried through the food chain 

to beneficial predators of pests. These findings from small scale studies cannot be readily tested at a larger 

and more realistic field scale in the U.K., due to current restrictions on GM field releases. This limitation on 

GM field experimentation means that in the U.K. we currently have to rely on modelling potential effects at 

larger scales, based on published or available information  on GM crops from other countries and from 

studies of the conventional (i.e. produced via plant breeding) pest–resistant crops currently grown in the U.K.  

 

The aim of this project was to build various types of models (classical ordinary differential equation and then 

individually-based) to examine potential effects of sublethal and lethal anti-insect (referred to as ‘anti-feedant’ 

traits in the project title, but actually covering the wider range of possible negative effects on pest survial, 

growth, dispersal and repoiroduction) traits in GM crops on the pest and predators of the pest. This was 

developed firstly using  bi-trophic models (pest-resistant GM crop and target pest)  and then extended to a 

tri-trophic model (pest-resistant GM crop, target pest and predators of the pest). 

 

As a basis for comparison and to aid development  strategies for sustainable use of future pest-resistant 

crops, we choose to compare lethal (e.g. Bt toxins) and sublethal (e.g. lectins) pest-resistant traits in the 

crop. This comparison provided a basis to examine effects of resource depletion and altered food quality at 

the pest and predator levels in the food chain. Our aim was to build in a range of physiological traits and 

parameters to cover a typical crop, pest and generalist predator into the generic models. Development and 

testing of the models was carried out largely on a bi- and tri-trophic systems using data for oilseed rape at 

the crop level, an aphid at the pest level and a ladybird at the predator level. This enabled us to select 

reasonably realistic parameter values from published literature for the plant, pest and predator life cycle 

models and feed them into the generic model for testing and analysis. 

 

A bi-trophic model,  based on a version of the Lotka-Voltera but modified to examine the effects of fitness 

differentials in 3 pest sub-populations, was established to explore the interactions and rate of adaptation of a 

herbivorous pest to a pest-resistant GM crop having logistic growth. This provided a phenotypic model 

without seasonal variability to examine evolution of pest adaptation to the GM pest-resistance trait. Three 

different pest sub-populations were defined (i.e susceptible to the GM trait, partially adapted, fully adapted) 

by differing the parameter  values for pest respiration rate and palatability (food value) of the crop. 

Expressions estimating the rates of increase of the fitter pest types were obtained as a function of food 

qualities, respiration and mortality rates. Although the model was formulated for single pest resistance gene 

it could be used and interpreted independently of this, allowing greater flexibility than previously published  

genetical models which were based on the Hardy-Weinburg equilibrium equation.  The effect of using refugia 

(patches of pest-susceptible crops) on delaying the rate of counter-adaptation in the pest sub-populations 

was examined. The model demonstrated trade-offs  when using pest-susceptible refugia crops; they did  

slow down pest sub-population adaptation rates (due to decreased fitness differential between pest sub-

populations and hence reduced selection pressure for counter-adaptation) but inevitably reduced total crop 
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yield (primarily due to crop loss in the refugia). It was noted that for this GM deployment strategy to work it 

requires good mixing of pest sub-populations. Thus, accurate knowledge of pest movement (distances, 

times) and mating behaviour (synchronicity of pest sub-populations) are critical before designing spatial 

layouts of pest-susceptible refugia areas within areas of pest-resistant GM crops. For full details see Hillier & 

Birch 2002a. 

 

We next examined how a sub-population of the pest which was under selection for counter-resistance to the 

GM trait would spread over space and time. A spatially-explicit reaction-diffusion system model, based on 

the modified Lotka-Volterra model above,  was used. This model incorporated  logistic growth of the crop 

resource and a diffusion term added to account for spatial spread of the pest over time. The model 

developed is phenotype specific, in which a pest sub-population’s fitness (energy reserve for growth and 

reproduction)  is a balance between its resource assimilation rate and its respiration rate. We derived an 

expression for the rate of spatial spread of the counter-adapting pest sub-population from an intial point 

source in the field. The model was then used to examine different strategies for delaying pest counter-

adaptation to the GM trait. Exploration of the model under different scenarios (principally differing sizes of 

refuge) revealed that counter-adaptation by the pest could be avoided when sufficiently large refugia areas 

were deployed, particularly if there was a metabolic cost to counter-adaptation in the pest sub-population. 

Spread from “hot-spots” of counter-adaptating pests could be avoided by deploying refugia  of suitable size 

and spatial positioning. Again, trade-offs were observed between crop yield (plant biomass) and refugia size. 

Whether or not the use of refugia is desirable will depend on the specifics of the system – the amount of 

yield loss that occurs, the reduction in the rate of growth of  counter-adapting pests caused by the refugia 

and the cost:benefit balance from using pest-resistant GM crops. Key factors in the model which need to be 

characterised accurately for particular a crop-pest interaction were identified as the functional form of the 

pests’ movement response  to resource suitability and the dispersal mechanisms of the pest. For full details 

see Hillier & Birch, 2002b. An interesting result from this article was that, when growth of the resistant pest 

population is restricted by its need to grow in space the form of the growth curve changes from a sigmoidal 

one as shown in Figure 1, to a linear one – with a significant time lag – as shown in Figure 2. This is in 

agreement with the results of Peck et al 1999, who constructed a rather different spatially explicit model for 

pest control, and concluded that the difference may well be down to the necessity for the pest to spread in 

space. Thus, the importance of understanding the role of spatial heterogeneity when making predictions 

about such systems is higlighted.  

 



Project 
title 

A generic mathematical model for the Integrated 
Management of a crop containing antifeedant transgenes 
      

DEFRA 
project code

RG 0115 

 

CSG 15 (Rev. 6/02) 6 

 

Figure 1 Pest adaptation in a spatially implicit bi-trophic model 

 

 

 

Figure 2 Pest adaptation in a spatially explicit bi-trophic model 
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In the third of the publications (Hillier et al, In prep) on this subject we have explored (i), how the influence of 

environmental fluctuations in resource levels (due to harvesting and resowing), (ii), increased physical 

realism in the functional response, may affect the prediction of the rate of adaptation derived in Hillier & 

Birch, 2002a. We also make a comparison of the result to that which might be obtained if toxic pest control 

measures were used. The results obtained in  Hillier & Birch, 2002a seem surprisingly robust, in spite of the 

rather unrealistic restrictions that were employed to enable analytical solutions of the model. 

 

In order to assess environmental risk in terms of predator extinction our starting point was the following 

classical tri-trophic modelgiven as follows 

 

 

 

Where C represents crop biomass, A represnts pest biomass, and P represent predator biomass. The lower 

case and Greek letters represent the parameters defining the population traits, and in particular �A and �P 

represent the pest and predator assimilation coefficients respectively for the given crop and pest 

respectively. The dynamics of such a system can be studied in terms of the values of its parameters, and in 

particular the food qualities, by which we can arrive at Figure 3. 

 

However the model displayed above also makes assumptions about the uniformity of crop, pest, and 

predator abundances, and constancy of environment. If the functional responses of the species are changed 

to represent spatial non-uniformity, or if the crop levels fluctuate to model harvesting and resowing the 

predictions will change.  

 

The spatially-explicit, individual-based, tri-trophic model was developed to allow all of the constraints 

encountered above to be relaxed. Results from the above models can then be tested for robustness, when 

the assumptions employed in their formulation and analyses are relaxed. 

The approach is a significant departure from the above, where instead of assuming certain processes and 

parameters to be important whilst trying to preserve the tractability of the analysis, we instead, intensively 

parameterise individual objects in the model in terms of their life strategies, and then simulate an ecosystem 

by advancing the model one time step at a time and observing the outcome. 
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Figure 3 Regions of crop, pest and predator  persistence in a tri-trophic model. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The model has been built, as a continuation of the work described above, to allow exploration of the issues 

of pest control and biodiversity management on an annual crop. With this in mind individual plants, 

herbivores, and predators are programmed to act and make decisions, based largely on their energy 

budgets, on a 2D spatial grid. The traits of the individuals, determine their ecological strategy, and thus, 

along with exploitative competition rules, determine the success or failure of individuals or “ecotypes” in the 

model. 

 

Traits and rules were selected to enable significant variation in strategies between the individuals, although 

our intent, was to ensure the existence of a clear physiological interpretation, although this was not always 

the possible, particularly when we are concerned with internal energy budgetting by the pest, were we have 

used the slightly abstract notions of Free store, and Structural store. 
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The parameters for herbivores (and predators) are based around 5 different fitness determining components: 

(i) Energy budget, (ii) Dispersal, (iii) Reproduction, (iv) Development, and (v) Foraging. The choice of 

generic traits and rules can be disputed, since they do not hold for all insects. However, we felt that they 

were the probably the best rules that can be programmed without especially intensive literature searching 

and parameterisations, which were beyond the scope of the current project.  

 

The rules for resource demand rates and assimilation efficiencies have come from a literature trawl of much 

of the insect energy budget work done in the 1960s & 1970s (For example Beddington et al 1976, and 

Hassell et al 1976). Gutierrez and colleagues have also extensively employed such models, and the 

approach can be found summarised in Gutierrez 1996.  

 

Allometric laws governing rates of respiration can be found in Peters 1973. The general rule is that 

respiration rate increases with the three-quarter power of body mass, and exponentially with temperature. It 

also increases linearly with distances moved.  

 

The rules for dispersal and reproduction were of our own devising. They allow for several alternative life 

strategies. 

 

Development rate increases linearly with temperature, and can increase linearly with resource captured. This 

“thermal time” approach has been much debated, and is unlikely to be validated or invalidated in the near 

future, although there is plenty of empirical evidence to support it. It is employed for reasons of parsimony, 

since (being a linear relationship) all it requires is intercepts and slopes. 

 

The model was coded in C++. An NT based visual front end has been coded to facilitate parameterisation of 

the model and also graphical visualisation of the output. It also allows the user to save  plant, pest, and 

predator parameters, so that a database of well parameterised ecotypes can be acquired over time. A full 

description of the  interface is attached (Matthews & Hillier). 

 

The model allows for a range of different plant distributions to be used (Figure 5). This means that various 

strategies that propose the spatial mixing of pest resistant with non-pest resistant plants can be tested in 

order to see whether (i) Mitigation of adverse environmental effects is possible, and (ii), The adaptation of 

the pest species due to fitness differential can be delayed. 
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Figure 4 A sample of the output from the model's visual interface 
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Figure 5 Example plant distributions allowed by the model interface (See User interface document).  

 

 

Detailed decription of the parameters used for the final version of  the tri-trophic model and 
instructions for running. 
 

User-controlled parameters can be categorised into 7 different classes. 

 

1. Environment 

2. Plant 

3. Herbivore 

4.Predator 

5.Plant-Herbivore interface 

6.Herbivore-Predator interface 

7.Initial conditions. 

 

In the herbivore and predator classes (3, 4) the parameters can be put into subclasses for  

a)  Energy Budget 

b)  Dispersal 
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c)  Reproduction 

d)  Development 

e)  Foraging 

 

These are further  partitioned as explained below: 

 

1.Environment; 
 

E1   Lattice length 

E2   Lattice width 

E3    Minimum annual temperature 

E4   Maximum annual temperature 

E5   Temperature at sowing 

E6   Season length 

E7   Number of seasons  

 

 

2. Plant;  
 

Pl1(1...3)  Maximum Biomass 

Pl2(1...3)  Maximum Phloem 

Pl3   Minimum phloem to biomass ratio for plant growth 

Pl4   Growth rate 

Pl5   Maximum seed mass 

Pl6   Minimum phloem to seed mass ratio for seed production 

Pl7   Development units required for elongation 

Pl8   Minimum temperature to initiate growth 

Pl9    Per day degree development rate 

 

3. Herbivore 
 

a) Energy Budget 

H1   Daily food demand rate 

H2   Food demand rate increase with temperature 

H4   Respiration rate at base temperature 

H5   Respiration rate increase with temperature 

H6   Proportion of assimilated food allocated to energy reserves 

 

 

b) Dispersal 
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H7   Energy threshold for dispersal  

H8   Exponent on dispersal probability function 

H9   Average distance moved during dispersal 

H10   Energy cost for movement (per spatial unit moved) 

   

 

c) Reproduction 

H11   Egg mass 

H12   Energy reserves in egg 

H13   Energy reserves required in adult for egg production 

H14   Egg laying must not take energy reserves below this 

H15   Maximum number of reproduction events 

H16   Egg viability 

 

 

d) Development 

H17   Base temperature of insect 

H18   Optimal temperature of insect 

H19   Maximum temperature at which development can occur 

H20   Daily development at optimal temperature (H18). 

H21   Additional development occurs if this consumption rate is exceeded 

H22   Additional development occurring if demand is met 

 

 

e) Foraging 

 

H24   Plant part that herbivore consumes 

H25    Overwintering survival rate 

 

 

4. Predator 
 

a) Energy Budget 

Pr1   Daily food demand rate 

Pr2   Food demand rate increase with temperature 

Pr4   Respiration rate at base temperature 

Pr5   Respiration rate increase with temperature 

Pr6   Proportion of assimilated food allocated to energy reserves 
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b) Dispersal 

Pr7   Energy threshold for dispersal  

Pr8   Exponent on dispersal probability function 

Pr9   Average distance moved during dispersal 

Pr10   Energy cost for movement (per spatial unit moved) 

   

 

c) Reproduction 

Pr11   Egg mass 

Pr12   Energy reserves in egg 

Pr13   Energy reserves required in adult for egg production 

Pr14   Egg laying must not take energy reserves below this 

Pr15   Maximum number of reproduction events 

Pr16   Egg viability 

 

 

d) Development 

Pr17   Base temperature of insect 

Pr18   Optimal temperature of insect 

Pr19   Maximum temperature at which development can occur 

Pr20   Daily development at optimal temperature (Pr18). 

Pr21   Additional development occurs if this consumption rate is exceeded 

Pr22   Additional development occurring if demand is met 

 

 

e) Foraging 

 

Pr24   Search radius 

Pr25   Coefficient for preferred prey size 

Pr26   Exponent for preferred prey size 

Pr27   Coefficient for tolerance for prey not of preferred size 

Pr28   Zero tolerance energy threshold for predator 

Pr29   Min food quality 

Pr30   Max food quality 

Pr25    Overwintering survival rate 

 

 

5 The Plant-Herbivore Interface 
  
H3 (1...#plant types) Assimilation efficiency 
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H23(1..#plant types) Apparancy of plant resource to herbivore 

 

 

6 The Herbivore-Predator Interface 
 
Pr3 (1...#pest types) Assimilation efficiency 

Pr23(1..#plant types) Apparancy of herbivores to predator 

 

 

7 Initial Conditions 
 
These may be either random of regular. See the full model description (Appendix 1) for details of allowable 

distributions and controls for setting parameter values. 

 

A demonstration of the working tri-trophic model,  with front-end user interface is included with this 
report (see CD), along with documentation.. 

 
Outputs from the project to date: 
 

a)Hillier J.G. & Birch A.N.E. (2002). A Bi-trophic model for Pest Adaptation to a Resistant Crop, J. 

Theor. Biol., 215, 305-319. 

b)Hillier J.G. & Birch A.N.E. (2002). Travelling Waves of Resistance in a Bi-trophic Pest Adaptation 

Model. J. Theor. Biol 

 ( In press.) 

c)Hillier J.G. & Birch A.N.E. (2002)  IOBC Working Group on Breeding for resistance to insects and 

mites. Rostanga, Sweden, December 2001. "A tri-trophic model to explore insect community 

response to the introduction of a pest-resistant GM crop".  (Invited presentation). 

d)Birch, A.N.E., Jones, A.T., Fenton, B., Malloch, G., Geoghegan, I., Gordon, S.C., Hillier, J. G., and 
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trophic model: Contrasting the effects of lethal and sublethal plant toxins. 

i)Hillier J.G.,  Birch A.N.E. , Crawford, J.,  Squire G.R., Hawes, C., Maule, M. 
 
j) (2002). Powerpoint presentation: A Spatially-explicit, individual-based, tri-trophic model for pest control 

(see enclosed CD). 
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 Applications of the model in ecology and agronomy  
 
The models developed in the Project are primarily research tools. In constructing them, the project staff have brought 
together and systematised a great amount of experimental information  that was otherwise fragmented in the literature. In 
particular, some generic aspects of trophic relations – notably the parameters that are used to link resource to consumer 
in each trophic interaction - can be applied by means of the model to a wide range of circumstances, as follows. 
 
(a) Design of cropping arrangements (mixtures, refugia) 
Insect populations usually become resistant to a practice used to control them only after the majority of susceptible 
insects have been removed by that control practice. The remaining insects that carry genes for resistance mate with each 
other and the resulting resistant insect populations subsequently increase in numbers, making control difficult. Examples 
of control practices that insects have become resistant to include crop rotation, traditional host plant resistance, and 
pesticides (including sprayable Bt formulations). In order to slow down insect resistance to GM crops expressing 
insecticidal proteins, scientists have developed various models and Insect Resistance Management (IRM) strategies. The 
“high dose-structured refuge” model is most widely adopted in countries including USA (Bt maize) and Australia (Bt 
cotton). This system depends on inter-breeding between potentially resistant pest individuals (i.e. selected on the GM 
insecticidal crop) and potentially susceptible individuals (from non-insecticidal refugia crop(s) or weed hosts of the pest). 
The heterozygote pest offspring are then killed by a high dose of the toxin in the GM crop, thus diluting the selection for 
counter-resistance to the insecticidal toxin in the overall pest population.  

Existing mathematical models supporting the use of refugia in GM crops are generally based on the Hardy-
Weinberg equation and knowledge of initial gene frequencies (for toxin counter-adaptation) in the target pest population. 
The models developed in this project go beyond the pest genotype and instead use phenotypic, behavioural  and 
ecological data to predict the fitness of insect sub-populations, based on a balance between resource assimilation and 
respiration rate in each pest individual. Spatial data for the pest and its host plants are also built into the model. This 
means that our models can be developed to investigate optimal spatial and temporal distributions of pest-resistant and 
pest-susceptible plants (e.g. in seed mixes, rows or blocks) to delay counter-adaptation in the pest population. The 
importance of using spatio-temporal data and models to assist in the design of pest-resistant GM crop deployment 
strategies is supported by recent field studies (Proceedings of the Royal Society 267, 117-122 and 1177-1184). In 
specific  cases where pest sub-populations do not readily inter-breed (e.g. in French studies on European corn borer, 
where pest sub-populations develop on several wild plant species around maize fields) our model and this recent field 
data indicate that a strategy based on use of wild host species in adjacent fields as a pest-susceptible refuge is unlikely to 
delay pest counter-resistance. As a second example, if the target pest readily moves between neighbouring plants to feed 
during its larval stages, a random seed mixture of resistant and susceptible crop genotypes is unlikely to deliver a 
sufficiently high toxin dose to kill heterozygote pest genotypes having intermediate toxin tolerance. In this scenario the 
pest could rapidly counter-adapt to the insecticidal GM toxin. However, in a third scenario,  where structured refugia (e.g. 
large blocks of a pest-susceptible variety) enable toxin-susceptible pest genotypes to readily interbreed with toxin-
resistant geotypes, our model predicts, in agreement with Hardy-Weinberg based gene frequency models, that pest 
counter-resistance to the insect resistance trait can be substantially delayed, particularly if there is a large fitness cost to 
counter-adaptation in the pest genotype. Confirmation in the field of such fitness costs in pest populations has recently 
been found in Australian studies on the cotton bollworm Helicoverpa armigera; the Bt-resistant strain was found to 
develop more slowly on conventional cotton than the Bt-susceptible strain and even more slowly on Bt-cotton (CSIRO 
web report – www.cotton.pi.csiro.au/publicat/conf/).  Our models can also be used to explore the rate of spread of GM 
crop-resistant pests and the potential trade-offs, in terms of crop yield, when pest-susceptible refugia of differing 
proportions are deployed with a pest-resistant GM crop. These types of exploratory mathematical models, once further 
developed to include more fully  the third trophic level (natural enemies of pests), should assist ecologists and 
governmental policy makers draw up Insect Resistance Management regulations for maximizing the durability of pest 
resistance genes in crops (GM or conventional). 
 
(b) Design of crop genotypes, both GM and non-GM  
Genetic improvement programmes that incorporate resistance to invertebrate pests are in place for all major crops in the 
world. New crop varieties that include GM traits conferring insect resistance are being deployed in many countries outside 
Europe. The insights gained from this project indicate that, where natural predators have a role in controlling pest 
populations, greater stability of the crop-pest-predator system will ensue if pest resistance is of a form that impairs growth 
and reproduction of the pest (i.e. sublethal effects) rather than kills the pest outright. This conclusion applies for both GM 
and non-GM pest resistance and could be used to define crop ideotypes that fit the local crop-pest-predator system. 
These ideas on the stability of crop-pest-predator systems could be tested by experiment at the appropriate scale, i.e. in 
experimental treatments of large enough area to support the life cycle dynamics of pest and predator. 
 
(c) Exploring options for balancing biodiversity and crop productivity 
As originally planned, the model incorporated a simple tri-trophic system, but the capacity to vary the trophic parameters 
among individual organisms in the modelallows the spatially explicit version to explore more complex food webs. Several 
ecological problems could be examined by the model. For instance, a major issue of interest for arable food webs is 
whether the mass of resource in the plant or weed layer limits consumers in higher trophic layers. It is generally assumed 
that such resource-limitation does occur in intensively managed systems, but experimental evidence is lacking. However, 
the model could be used to explore the parameters of the resource-consumer relation, i.e. the extent to which varying the 
weed mass affects mass-transfer to herbivores and higher functional groups. A second topic is the way variety in the plant 
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layer affects the type and abundance of organisms in higher trophic groups.  Again, the parameters of individual plants 
could be varied and the consequent coexistence of invertebrate types (species, traits) examined. The model could be 
used in such ways to explore major questions in arable ecology, to set hypotheses and to guide experiments. Several 
generic questions that are likely to arise from the Farm Scale Evaluations of GM crops in GB could be approached using 
the model. 
 
The models are now being used within SCRI’s research programmes on biodiversity in arable fieldsand integrated pest 
management.  Several possible applications have also been considered with other scientists, for instance in the 
BBSRC/NERC initiative in Geneflow in Agriculture. Staff at SCRI are most willing to collaborate with external groups in 
the use of the model for ecological or agronomic purposes. Ultimately, the models constructed in this project have the 
potential for development as a management tool, for example to optimise biodiversity in relation to production in arable 
systems. They would however, need further development for this general function.  
 
 
 
 
N. Birch, J. Hillier, GR Squire 
February 2003 
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Appendix 1: 
 

Cropest: User interface for tri-trophic model 
 

User Manual (also supplied on CD with demonstration version of model) 
 

The model was developed at the Scottish Crop Research Institute by Jon Hillier with contributions from 

Nick Birch (Project Officer), Geoff Squire, Cathy Hawes and John Crawford (now at the University of 

Abertay Dundee). David Matthews, a graduate student in the Department of Applied Computing at the 

University of Dundee, constructed this User Interface as a M.Sc. project supervised by Chris Reed from 

the University of Dundee and Jon Hillier.  

 

The model was funded by DEFRA through Project RGO115. 
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1. Introduction 

The Cropest application provides a visual front end for the Individual-based Tri-trophic model developed at the 
Scottish Crop Research Institute (SCRI). This manual describes the use of the Cropest interface. 

1.1. The SCRI model 
The model has been built primarily to allow exploration of the issues of pest control and biodiversity 
management on an annual crop. With this in mind individual plants, herbivores, and predators are programmed 
to act and make decisions, based largely on their energy budgets, on a 2D spatial grid. The traits of the 
individuals, along with exploitative competition rules determine the success or failure of individuals or 
“ecotypes” in the model. 

1.2. The Cropest interface 
The Cropest interface allows a model-run to be set up by defining the participant species, their interactions and initial distributions 
along with the environmental conditions. The interface then provides a graphical rendition of the output from the model. The output 
can be reviewed as the model produces it and/or stored for later analysis. 
In addition Cropest allows for the separate storage of parameterised species for use in subsequent model runs. 
 

1.3. Required Expertise 
Cropest is designed to operate under the Windows NT4 operating system. As such, it is assumed that the user is 
familiar with the use of this operating system. 

1.Pull Down Menus 
In this manual when a selection from a pull down menu is required the shorthand => will be used. So select 
‘File => New...’ means select ‘New...’ from the ‘File’ pull down menu. 
2. Installation 
The Cropest interface and the SCRI model are two independent programs that communicate using files. Once installed correctly the 
user should only need to access Cropest. The model program will be executed automatically by the interface. 
Cropest needs to be installed in the same folder as the model program that it is required to operate. Cropest will only operate an 
application file named ‘trtr’. 
It is suggested that the two programs be installed in a specially created folder. 

2.1. Installing the software: 
Create a ‘New Folder…’ to hold the programs 
Copy the two application files: ‘Cropest.exe’ and ‘trtr.exe’ into the New Folder 
Create shortcuts to Cropest.exe wherever required (e.g. on the Windows desktop) 

2.2. Starting the interface 
The Cropest interface can be launched in any standard Window’s manner; for instance double clicking on the 
icon representing the application or a shortcut to it. 
3. Defining Species 

To gain familiarity with the interface, the defining of species can be looked at first. Species can be defined as 
part of the process of setting up a model (Chapter 5). They can though also be defined in isolation and then later 
loaded into models as required. As the definition of a species can involve setting thirty parameters, the ability to 
save them for re-use will save time 

3.1. The plant form. 
Once the interface is launched a blank screen is presented. To parameterise a species, without running a model, simply select the 
required trophic level from the ‘Specie’ pull down menu. 
Looking at plants first, select ‘Species => Plant’ and the Plant parameterising form (dialog box) will be presented.  
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Figure 1: Selecting Plant 

Numbers can now be entered into the boxes to define the plant’s characteristics. Please see chapter 4: parameter 
definitions for an explanation of the parameters. 

 

Figure 2: Plant Form 

If any changes are made to the form then pressing the OK button will offer the user the option to save the plant. This is saved as a file 
with the extension ‘.pla’. All of the parameter fields must be given allowable values before the plant can be saved. 
Pressing the ‘Load’ button allows such previously saved plants to be reviewed. If a previously archived plant is loaded and changes 
are made to its parameters then when the OK button is pressed the option to save these changes is given. The existing .pla file can be 
overwritten or a new file can be created leaving the original uploaded file untouched. 
The Cancel button enables the form to be quit at anytime without saving any changes made. 

3.2. Herbivores and Predators 
Herbivores and predators can be parameterised and stored in a similar way to plants. As they require more parameters to define them, 
the forms for herbivores and predators are sub-divided into pages. 
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Figure 3: Example page from Herbivore form 

Important hint: Once a page has been selected all of the fields on that particular page must be filled before another page can be 
viewed. If you need to consult another page before filling in a parameter you will need to insert a temporary value before you can 
change pages. 
As with plants, herbivores and predators can be archived. The OK, Load and Cancel buttons provide the same functionality as 
previously described for plants. Herbivores are stored with the file extension .hbv and predators with .prd. 
 
 
4. Parameter Definitions 
These are the explanations of the parameters for each type of species:  

4.1. Plant parameters 
Plants have either 5 or 7 compartments depending on their (eventual) height. The compartments are classified as “phloem”, 
“biomass”, or “seeds”. 

 

Figure 4: Plant compartments 

So compartments p[*] and b[*] correspond to the first 6 boxes in the Plant dialog box. 
For minimum phloem to biomass ratio we would expect a figure between 0 and 1. Values greater than 1 are allowed but are probably 
rather high. Plant biomass growth will stop if the overall phloem to biomass ratio is smaller than this figure. 
Growth rate. The higher this figure is the faster the plants maximum biomass will be achieved. Plant growth is loosely based around 
the logistic equation. Although growth rate can take any value greater than 0, values of greater than, say, 0.2 are likely to be 
unrealistic. 
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Maximum seed mass, is the optimum that can be obtained if conditions are good and there is no pest damage. 
Minimum phloem to seed mass ratio is analogous to minimum phloem to biomass ratio. Seed production will stop if there is 
insufficient phloem. Again, any value greater than 0 is allowed. 
Development units are day degrees above a threshold of Tbase, the Minimum temperature to initiate growth. This temperature is in 
degrees Celsius. For every day that the temperature, T, is above Tbase the plant achieves development units at a rate of Per day degree 
development rate * (T- Tbase). The plant is mature when it has a full development unit, at which point it commences seed production. 
Thus Per day degree development rate should generally be a number between 0 and 1, but much closer to zero. For example, for an 
oilseed rape a value of 0.0014 gives maturity at a reasonable time based on SCRI weather data. 
If the plant is a “tall” one, it will at some point move from possessing 4 (or 5) compartments to 6 (or 7), as it grows taller. This occurs 
when the number of development units passes a threshold Development units required for elongation. Thus, although, this parameter 
can take any positive real number, it is likely, at its maximum value, to be only slightly larger than 1 (in which case it is still growing 
significantly taller after seed production has commenced). 

4.2. Herbivore and predator parameters 
The parameters for herbivores (and predators) are based around 5 different fitness determining components: (i) Energy budget, (ii) 
Dispersal, (iii) Reproduction, (iv) Development, and (v) Foraging. 
The choice of generic traits and rules can be disputed, since they do not hold for all insects. However, we felt that they were the 
probably the best rules that can be programmed without especially intensive literature searching and parameterisations, which were 
beyond the scope of the current project.  
The rules for resource demand rates and assimilation efficiencies have come from a literature trawl of much of the insect energy 
budget work done in the 1960s & 1970s (For example Beddington, Hassell, & Lawton). Gutierrez and colleagues have also 
extensively employed such models, and the approach can be found summarised in Gutierrez 1996.  
Allometric laws governing rates of respiration can be found in Peters 1973. The general rule is that respiration rate increases with the 
three-quarter power of body mass, and exponentially with temperature. It also increases linearly with distances moved.  
The rules for dispersal and reproduction were of our own devising. They allow for several alternative life strategies.  
Development rate increases linearly with temperature, and can increase linearly with resource captured. This “thermal time” approach 
has been much debated, and is unlikely to be validated or invalidated in the near future, although there is plenty of empirical evidence 
to support it. It is employed for reasons of parsimony, since (being a linear relationship) all it requires is intercepts and slopes. 

4.2.1. Energy budget  
In this model the amount of resource that a consumer requires increases in proportion to its own mass. It also increases linearly with 
temperature.  
Daily food demand rate, Dbase, is the daily resource requirement (as a proportion of own mass) of the insect at its base temperature. 
Food demand rate increase with temperature, DT, is the additional demand (as proportion of own mass) for every degree Celsius 
above the insect’s base temperature. 
Total demand rate appears to vary across species but some species can consume more than their own mass in a day. So if, for 
example, we suppose demand at the base temperature to be very low, and said that temperature could vary by 10 degrees across a 
season, reasonable values might be Dbase = 0.1 and DT = 0.1. 
Respiration rate at base temperature, Rbase, is similar to Dbase. For many insect species it a value of around 0.02 has been found to be 
appropriate. 
Respiration rate, r, increases exponentially with temperature according to the law 

TR
base

TeRr =  
where T is temperature and RT is the Respiration rate increase with temperature. Values of around 0.04 are reasonable (Peters 1973). 
Our insects consist of 2 energy compartments, Free Store and Structural Store. Free store is energy that is available to meet the costs 
of reproduction and respiration. Proportion of assimilated food allocated to energy reserves, is thus the proportion which is directed 
to the Free Store. It can take any value between 0 and 1. If it is near 0 then the insect’s strategy becomes very risky since it is unlikely 
to have a huge energy reserve upon which it can rely if resource is scarce. 

2.Dispersal  
We regard dispersal and foraging as distinct activities, with foraging discussed later. 
Insects disperse if they are not getting sufficient energy to satisfy their needs at their current location. This is determined by the level 
of free store, the probability of dispersal occurring being negatively correlated with the energy reserves of the insect. 
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Figure 5: Dispersal probability 

If the proportion of the insect’s mass that is free store drops below Energy threshold for dispersal (ED on the graph) the insect will 
move. The distance it moves is randomly pulled form a Poisson distribution with mean Average distance moved during dispersal. 
If the proportion of the insect’s mass that is Free Store is above the threshold ED there is still a chance that the insect will move. The 
higher the Exponent on dispersal probability function (γ on the above graph) is then the less generally mobile the insect will be. We 
have no good idea for what values γ should take. To simulate a relatively immobile aphid species we have used a value of 100, 
whereas for some species, say beetles, which can be quite mobile, low values for γ of say 1 to 10 might be more appropriate. 
There is always a cost to movement. In the model the cost depends on the distance moved and the mass of the insect. Again, we have 
no clear idea what values Energy cost for movement should take, although we have used values between about 0.0001 and 0.001 in 
practice. It is worth noting that “mobile” insects with low values for γ are unlikely to be able to survive if their cost of dispersal is 
high. 

3.Reproduction 
Egg mass is the total mass of each egg. Energy reserves in egg is the amount which is Free Store, thus it is nonsensical for this value 
to be greater than Egg Mass.  
When an individual is adult, it will reproduce if the proportion of its mass that is Free Store is above the threshold Energy reserves 
required in adult for egg production. When it reproduces it will use up its free store, as long as the proportion of its mass that is Free 
Store does not drop below a certain threshold (Energy reserves must not drop below this).  
An individual can have a certain number of reproduction events before dying (Maximum number of reproduction events). For 
example, some species will only reproduce once, while others will continue to reproduce once they are adult until the end of the 
growing season. 
Egg viability is the proportion of eggs laid which are viable. Thus it takes values between 0 and 1. 

4.Development 
Base temperature of insect (degrees Celsius). Tbase. This is usually above 0o C. Below this temperature the insect is dormant. 
Optimal temperature of insect (degrees Celsius). Topt. At this temperature the development rate of the insect is maximal. 
Maximum temperature at which development can occur (degrees Celsius). Tmax. If this temperature is exceeded then the insect’s 
development rate drops back down to zero. 
Daily development at optimal temperature. (Devopt). An insect is adult when its number of development units equals 1. Thus for 
something like an aphid, which can mature in less than 10 days at optimal temperature a reasonable value might be 0.1. For a 
ladybird, which might take upwards of 30 days, a value of 0.03 would be more suitable. As the temperature moves away from Topt the 
development rate decreases linearly down to zero at either Tbase or Tmax.  
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Figure 6: Daily development at optimal temperature 

In some insect species the resource consumption rate also affects the development rate (e.g. Adalia decempunctata, Dixon 1962). We 
allow for additional development of through the parameters Additional development (DevD) occurring if demand (D) is met and 
Additional development occurs if this demand is exceeded, ρ, (as a proportion of mass of self). 

 

Figure 7: Additional development 
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5.Foraging 
In this case the herbivores and predators have different traits, partly because we allow predators the option of “intelligent” searching. 
The main differences, however, come about because herbivores generally consume parts of objects that are much larger than 
themselves, while predators usually consume the whole of objects that are either smaller or equal to themselves in size. 
Included among the foraging parameters is the Overwintering survival rate of the insect species. This is essentially the probability 
that any given individual will survive the winter and persist into the next year, so it should take values between 0 and 1. 

1.Herbivores 
Plant part that herbivore consumes. This may either be phloem, structure, or seeds. 

2.Predators 
Search radius. Predators have the ability to “see” prey in a circle around themselves of this radius. They will move to the cell that 
they believe has the most suitable prey in it (which cell they believe has the most suitable prey is somewhat dependent on the 
apparency parameters – discussed later). 
Prey choice for predators is rather complicated. We had to consider a number of factors when modeling this:  
(1) As a proportion of mass of self, prey size can vary with predator’s age 
(2) Prey acceptability increases as the predator gets more “hungry”. 
(3) Predators can choose between a number of different prey types. 
A day is divided up into a number of sub-units (fixed arbitrarily at 20) over which the predator forages. Although the amount of food 
required by the predator is set by its demand rate (defined earlier) the items it consumes to meet that demand may vary. In each time 
sub-unit the preferred size for the prey item is 
cMβ 
where c is the Coefficient for preferred prey size, and β is the exponent for preferred prey size. If the proportion of the predator’s 
mass which is Free Store is at Zero tolerance energy threshold for predator (FSzero), then the predator will not accept any prey which 
are not exactly equal in mass to cMβ. If the Free Store is below this threshold then the predator will accept prey of different sizes, the 
level of tolerance being greater if Coefficient for tolerance for prey not of preferred size, σ, is large.  
We have no idea of the range of biologically acceptable values, but values that have worked in practice (based loosely around 2-spot 
ladybirds) are  
c ≈ 0.1,  β ≈ 1,  FSzero ≈ 0.6,  σ ≈ 0.01. 
The Food quality is also of interest when the predator is choosing its prey items. This parameter, which is essentially a conversion 
coefficient, and can take values between 0 and 1, will be discussed later. A predator’s level of interest in a prey item will be somewhat 
dependent on the quality of that prey item. Minimum quality (φmin) is the threshold of the conversion coefficient below which the 
predator is not at all interested, and Maximum quality (φmax) is the threshold above which the predator is always interested. Although 
conversion coefficients themselves should always be between 0 and 1 we allow these parameters to be outside this range for reasons 
which should be clear from the graph below. 
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Figure 8: Food quality 

On the black line, the difference between φmax and φmin is small and the predator has a large difference of interest in prey types even if 
the difference in their food qualities is low. 
On the red line, if the prey conversion coefficient is zero the predator has no interest in it whereas if it is 1 then 
the predator is completely interested. 
On the blue line the difference between φmax and φmin is very large and the predator does not differentiate much between prey types of 
different qualities when choosing its prey items. 
 
This provides an explanation of all the basic parameters for individual species. We will now look at these in the context of a complete 
model. 
 
5. Setting Up a Model Run 
A full model run consists of defining the parameters for the model and the calculation (by the model software) of the spatial 
distributions of the participant species for the duration of that model run. Depending on the size of the model defined his may take 
hours or even days. 
To set up a complete model one should be familiar with loading existing species files into a species form (see chapter 3). With this 
knowledge it is possible to build models using species already parameterised and archived. If one wishes to define ones own species 
consult chapter 4. 
First launch the interface program (see chapter 2).  
NB: if the interface is already running it should not be in the process of currently performing a model run. If the Windows taskbar 
contains the Model icon (see below) it is probable that a model is already in progress. Chapter 6 discusses terminating a running 
model. 
Selecting ‘File => New’ will initiate the Model wizard which guides the user step by step through the process of defining a model’s 
parameters. 

5.1. Environmental parameters 
The first screen that appears allows the setting of the spatial and temporal size of the model, along with the temperature range. Default 
values have been provided but these should be altered as required. 
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Figure 9: New model 

Lattice length and width are the length of the lattice in the x and y directions. Run time for the simulation should increase 
approximately linearly with each Lattice length. Thus, although for the default size of 10 by 10 the model should run quickly, it is 
worth noting that a lattice of 100 by 100 will take approximately 100 times as long to run. 
Minimum temperature is the temperature at the start of the simulation and Maximum temperature is the peak temperature that can 
be achieved. Temperature at sowing will determine when the plants are sown in the model. 
Season length (days): each year will be of this length. Thus for the default values each year will run for 150 days before the plant is 
harvested and the herbivores and predators go into their over winter phase (see Overwintering survival rates, Chapter 4).  
Number of seasons: the simulation will finish after this many seasons. 
When you are satisfied with the numbers entered press ‘Next’ 

5.2. Adding Species 
The next three pages allow the addition of any number of species to the model. There is one page each for plants, herbivores and 
predators. All three pages have an identical format and operate on the same principals. Therefore the plant page is used to demonstrate 
these pages. 
Click on the ‘Add Plant’ box. A Plant dialog box will now appear. At this point the user can press Load to upload a plant previously 
defined and saved. Alternatively they may enter parameters manually. Once either method is completed pressing the OK button will 
add the defined plant to the list of plants.  
It is possible to Load a plant from file and then adjust some or all of its parameters. At this point pressing OK, as well as adding the 
plant to the model (using the altered parameters) will check whether or not to save the altered parameters. The original plant (.pla) file 
can be overwritten with the altered parameters or a new plant file created.  
The plant page with one plant species added is shown below: 

 

Figure 10: Add plant form 

This can be repeated for as many plants as required. If a plant is no longer required it is possible to remove it. Select the plant in the 
list by left clicking on it. Pressing the ‘Remove Plant’ button will then remove the highlighted plant from the list. 
The forms for adding herbivores and predators to the model operate in the same manner. 
It is necessary to add at least one plant and one herbivore to the model. 
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After the Add Predator page is completed the next page provides a ‘Finish’ button. It is important to note that once the Finish button is 
pressed this part of the Model Set-Up Wizard will be complete: it will no longer be possible to add or remove species to the model nor 
change the environmental parameters. Once Finish is pressed the Wizard moves on to define the species’ interactions.  
 

5.3. Plant Herbivore interactions. 
The interaction between pant and herbivore species is defined by two parameters for each inter-relation. Defining the interaction 
between crops and pests is done using the Herbivore-Plant interaction page. The user will be presented with one such page for each 
herbivore present in the model. 

 

Figure 11: Herbivore Plant interactions 

The name of the herbivore concerned is displayed at the top of the page. A list of plants present in the model is displayed to the left. 
The parameters defining the relationship between the herbivore and the plant highlighted in the list are displayed in the two boxes to 
the right. 
To enter the required information, select a plant from the list, by left clicking on it, and type the required numbers into the boxes. This 
must be repeated for every plant in the list. 
Two key components of a resource-consumer interaction are the Food Quality and it’s accessibility of the resource to the consumer. 
Food quality is defined as the Assimilation efficiency of the consumer when eating a given resource. Apparency is a parameter 
expressing how accessible the resource is to the consumer, and thus is a composite parameter which comprises say plant architecture, 
chemical composition, and foraging behaviour of the consumer. Each individual consumer will look at each individual resource type 
differently; thus these parameters need to be set for every resource type and every consumer type present.  
Although it might be tempting to skip through this tedious part of the process without thought to the parameter values, we would 
advise against this. Multi-trophic models tend to be highly sensitive to these parameters: Species will go through a range of dynamics 
from extinction, stable persistence, cyclic and chaotic dynamics based on the values defining the resource-consumer interfaces. 
For guidelines, from our literature searches we have found that Assimilation efficiency tend to average at between about 0.25 and 0.4, 
although there is substantial variation around this mean. 
Apparencies at the plant-herbivore interface have needed to be quite low to ensure persistence in food chain simulations (up to about 
0.1), although this may not be the case in true food webs, in which other species may help to stabilise the system dynamics and 
facilitate co-existence. 
Once the parameters have been added for each herbivore in the model another ‘Finish’ button is presented. Again at this point, once 
Finish is pressed it will not be possible to alter the Plant Herbivore interactions. 

5.4. Predator Herbivore interactions 
If any predators are present in the model it will be necessary to define their relationships with the herbivores. Again for each prey type 
present, each predator needs Assimilation efficiency and apparency parameters set. 
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The layout and operation of the Predator-Herbivore interaction pages is almost identical to that of the Herbivore-Plant. Except 
herbivores now appear in the list and each page deals with one predator. 

 

Figure 12: Predator herbivore interaction. 

Again the system is sensitive to the parameterisation, and, although values for Assimilation efficiency appear to average somewhere 
between 0.25 and 0.4, we have less idea about what are suitable values for the Apparencies. 
Once the desired parameters have been entered for all of the predators another ‘Finish’ page is presented. Again no change to the 
Predator Herbivore interactions can be made after ‘Finish’ has been pressed. This will move the wizard on to the initial distribution 
section. 
 

5.5. Initial distributions 
It is necessary to supply the initial distributions of the herbivore and predator populations in the model. If there is more than one plant 
present in the model information concerning their mixture will need to be supplied. 

6.Plants 
In the case that there is only one plant species present in the model, the Set-up Wizard will proceed directly to the distributions for 
herbivores. 
If there are two plants present in the model the following form is presented: 
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Figure 13: Plant distribution-2 Plants. 

The first plant added to the model is assumed to be the main crop. It is only necessary to set the distribution for the second plant. 
If Random is chosen a probability that the second plant will be sown at any given lattice point is entered. 
The grid-based choice allows the two plants to be sown in a regular pattern of alternate blocks. The size of these blocks defined by the 
two parameters, X and Y. X and Y are measured in the same spatial units used to define the lattice size (see Environmental 
parameters). If X and Y are equal this will give a regular square patterning, like a chessboard. If, say, Y is set to equal the lattice 
length then this will give a striped pattern of width determined by X. 
If more than two plants have been added to the model it is only possible to specify a probability for the distributions of the plants. 
The form to allow this is shown in figure 14: 
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Figure 14: Plant Distribution- more than 2 Plants 

Each plant is selected in the left-hand list and a probability for its sowing is entered in the probability box. These probabilities take the 
range 0 to 1 for each plant. The model averages the probability values to calculate the distribution of the plants. 

7.Herbivores and predators 
The herbivore and predator distributions are defined as either random or regular using the following form. 
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Figure 15: Insect distribution form 

If a random distribution is selected then the user has to enter the concentration, that is the average number of insects per plant. 
If regular is selected the user specifies the x and y coordinate of a point source. Then enters the number of insects at this point into the 
‘Population at location’ 
If the ‘Repeat regularly over grid’ box is checked then the sites (2x,y), (3x, y)…(x, 2y), (2x, 2y), (3x, 2y)… etc will also be filled. The 
‘Population at location’ will be ascribed to each of these points. 
 

5.6. Running the model 
Once all the parameters have been entered the screen informing the user that the model will now be started is displayed. Pressing the 
‘Finish’ button to confirm that you have finished entering all the data starts the model. 
The Model program is launched as a minimised window. That is it only appears in the taskbar and should look like so: 

 

Figure 16: Model program icon 

For details on operation of the interface once the model is running please see chapter 6. 
6. Viewing a Model Run 

Once the model has been started the display will appear as in figure 17. The initial display shows the first plant 

in graph 1, the first herbivore in graph 2 and the first predator in graph 3. As the model program generates each 

new timestep’s data it will be displayed on the interface. 
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Figure 17: The model viewing interface 
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6.1. Graphs 
The name of the species shown in each graph is shown in its respective graph control panel: 

 

Figure 18: Graph control 

Clicking the down arrow to the right of the species name will present a drop-down list containing the names of all the species present 
in the model. Clicking on a species name will cause that species data to appear in the relevant graph. 
If a plant species is selected the scale on the graph will represent the maximum overall biomass that plant could achieve (The sum of 
maximum biomass, phloem and seed mass). 
For insect species the scale will represent the maximum population achieved by the species. As the eventual maximum population 
will not be known until a model run has finished this scale will change whilst the model program is still generating output. 
The style of the graph can be selected from the three available. 
The  button allows the parameters of the species displayed in the graph to be reviewed. The species parameters appear in a form 
identical to the form used for defining it except that the parameters are read-only. 

6.2. Rotation 
The three graphs can be rotated, in unison, by the use of the four rotation buttons. The button required is simply held down using the 
mouse until the desired view is achieved. The graphs all move in unison: it is not possible to rotate a graph on its own. 
The up and down buttons only allow for a rotation of ± 90 º. 
If a graph style is set to 2D it will not appear to rotate. However if the style is later set to 3D or grid the graph’s aspect will match that 
of other graphs that have been rotated. 
If the rotation appears slow or jerky this may be because the model program uses a large amount of processing power. Once the model 
program has generated all the data and closed down the rotation should appear much smoother. 
 

6.3. Enlarging 
There is no zoom control provided but it is possible to alter portion of the screen allocated to each graph. The bars dividing the graphs 
can be dragged around the screen. Simply position the mouse over the bar, hold the mouse button down and drag the bar to its new 
desired location. It is possible to adjust both bars simultaneously by dragging their intersection. 
This allows one graph to fill the available screen space as illustrated: 
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Figure 19: Enlarging a graph 

 

6.4. Timestep controls 
The timestep control allows the interface to play backwards and forwards through the model output. The current timestep showing on 
the graphs is displayed below the timestep controls. As with rotation the timestep shown can only be altered for all of the graphs in 
unison. 
The timestep controls are modeled on the controls for a video or audio cassette player and provide the following functions: 

 Jumps back to the first timestep of the model. 

 Plays backwards from the current timestep to the beginning of the model. 

 Moves backward one timestep from the current timestep. 

 Moves forward one timestep from the current timestep. 

 Plays forwards from the current timestep to the end of the model. 

 Jumps forwards to the last timestep of the model. 

 Stops the timestep if it is continuously playing. 
It is possible to use the timestep controls to navigate temporally through the model whilst the data is still being generated. In this case 
the ‘last’ timestep will be the last timestep for which data has so far been generated. 

6.5. Stopping a model run 
Important: If it is required to end a model run part way through its generation it should be done by closing the model in the interface. 
This can achieved by selecting ‘File => Close’. 
The program will confirm that you wish to end the model prematurely. The interface will then offer the option to save the model 
output (See chapter 7). It is possible to archive partially generated models. 
It is not recommended to close the model program directly oneself, as this will leave the interface awaiting data. This may cause 
unexpected and undesired results if a second model run is undertaken. 
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7. Loading and Saving Models 

7.1. Saving 
Once a model has been generated it may be archived for later review, or comparison with other models. This is done by selecting ‘File 
=> Save’. If a model is closed without saving it the option to save it will be given before it is closed. Model files are saved with the 
extension .mod. 
Saving a model saves all of the spatial timestep data as well as the parameters for the species involved. 
As noted previously, it is possible to save part generated models. It should be noted though that such a model cannot be ‘re-started’. 
Only the data generated prior to the model being stopped will be available for review. 

7.2. Loading 
Loading an archived model is achieved by selecting ‘File => Open’. The required model file is then selected and will be displayed. 
The model can be reviewed using the controls as outlined in chapter 6. 
It is possible open more than one archived model at a time allowing comparisons to be made. The ‘Window => Tile’ and ‘Window => 
Cascade’ options can be used to help organise several models. 
It is possible to open archived model whilst another model is in running. 
It is not possible to open one archived model twice, simultaneously. This would be useful to compare for instance different timesteps 
within the same model. The only way this can be achieved is to make a copy of the .mod file, using Windows Explorer. The original 
and the copy can be opened simultaneously to allow comparisons to be made. 
 

7.3. Exporting 
The format of the .mod files is such that it can only be read by the interface program. If any analysis of the data is required by other 
applications it is necessary to create a file of the data legible to other applications. 
The interface therefore provides the capability to export the data in a tab delimited text format. 
To do this select ‘File => Export...’ 

 

Figure 20: Data exporting 

The data for a single species can then be exported for any range of timesteps selected. 
The file exported has a .dat file extension. Notepad or Microsoft Excel can read its textual format, for instance. 
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Figure 21: Exported file opened in Notepad 

 
 
 
 


